
1

Contents

0 Introduction 5

0.1 Activity: Mathcad Regions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6

0.2 Activity: Mathcad Basics . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9

1 Limits 14

1.1 Activity: Limits . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14

1.2 Homework Help . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21

1.3 Questions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22

2 Di®erentiation 24

2.1 Activity: The Derivative . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24

2.2 Activity: Introduction to Symbolics . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31

2.3 Homework Help . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 36

2.4 Questions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 37

3 Applications of Di®erentiation 39

3.1 Activity: Curve Sketching. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 41

3.2 Activity: Optimization. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 45

3.3 Homework Help . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 48

3.4 Questions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 48

4 Integration 51

4.1 Activity: Riemann Sums and the Fundamental Theorem of Calculus . . . . . . . . . . . . . . . . . 51

4.2 Homework Help . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 54

4.3 Questions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 55

5 Transcendental Functions 57

5.1 Activity: Logarithmic and Exponential Functions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 57

5.2 Activity: Symbolic Integration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 60

5.3 Activity: Functions De¯ned by Integrals . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 64

5.4 Homework Help . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68

5.5 Questions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69



2 Chapter 0

6 Applications of Integration 71

6.1 Activity: Area of a Region Between Two Curves . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 71

6.2 Activity: Volume of a Solid of Revolution . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 73

6.3 Activity: Arc Length . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 75

6.4 Activity: Area of a Surface of Revolution . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 76

6.5 Homework Help . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 77

7 Integration Techniques and Improper Integrals 78

7.1 Activity: Integration Techniques . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 80

7.2 Activity: Improper Integrals . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 82

7.3 Homework Help . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 84

8 In¯nite Series 85

8.1 Activity: Sequences . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 85

8.2 Activity: In¯nite Series . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 90

8.3 Homework Help . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 96

9 Conic Sections 98

9.1 Homework Help . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 98

10 Plane Curves, Polar Curves 99

10.1 Activity: Parametric Curves in the Plane . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 99

10.2 Activity: Polar Curves . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 111

10.3 Homework Help . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 116

11 Vectors and the Geometry of the Space 118

11.1 Activity: Vectors . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 118

11.2 Activity: Lines and Planes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 120

11.3 Homework Help . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 123

12 Vector-Valued Functions 124

12.1 Activity: Vector-Valued Functions. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 124

12.2 Homework Help . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 131

13 Functions of Several Variables 132



3

13.1 Activity: Partial Derivatives and Chain Rules . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 132

13.2 Activity: Normal Lines, Tangent Planes and Extrema . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 137

13.3 Homework Help . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 138

A Mathcad Summary 140

A.1 Menu items with button and keyboard shortcuts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 140

A.2 Mathematical Operators . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 141

A.3 Mathematical Functions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 141

A.4 Built-in constants . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 142

A.5 Additional Mathcad operations and functions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 143

B Seven Things to Avoid When Working in Mathcad 144



4 Chapter 0



5

0 Introduction

Welcome to computer activities for Calculus. We hope the manual will be useful to you in several
ways:

² as a lab assignment guide;

Activity sections are included in almost all the chapters. Your professor will assign problems
from these sections to be solved and formally turned in. Other problems may be worked through
during in-class computer activities. Nearly all the activities of this manual involve Mathcad

(version 5.0 for Windows). Several activities also require Maple V (release 3 for Windows).

² as a self study guide;

Homework Help sections are designed to allow you to use technology to aid you with your
solution of homework problems from the text. For example, a graph obtained on the computer
screen can frequently verify that your solution (obtained with a pencil and paper) is correct.
A graph can also help you understand the nature of the problem that you have solved (all too
frequently, such understanding does not automatically accompany algebraic skills).

Some chapters also include a Questions section, intended to help you assess the insight you
gained into the visual and numerical aspects of the calculus concepts discussed.

² as a reference;

While this guide is not intended to be a software manual, you will hopefully ¯nd it provides
useful information to aid in the use of the software during your calculus course(s), as well as
afterwards. Software-related information, most of which is given in the course of the activities,
is fully indexed for convenience. Appendix A contains a summary of Mathcad operations and

functions. Appendix B includes a list of common problems encountered by students while
working with Mathcad.

Key to the symbols

The abbreviation "LHE" denotes a reference to the "Calculus with Analytic Geometry" text by
Larson, Hostetler and Edwards (D.C. Heath, 5th Edition).

Whenever the symbol appears, a Mathcad template ¯le is used; similarly, denotes a

Maple V template ¯le. Your professor should give you further information about accessing these
¯les.
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sin( )x

x

cos( )x

x

x ..,0 0.1 19

Figure 1: Make the right side look like the left!

0.1 Activity: Mathcad Regions

Every Mathcad document is made up of a number of regions, which may involve algebraic expres-
sions, graphs, tables, text, or other items. As a Mathcad user, you have the ability to create regions
of various kinds, and to lay them out in your document in a °exible manner.

In the next activity, "Mathcad Basics", you learn how to create Mathcad regions to perform
calculations, graph functions, solve equations, etc. Before that, however, this brief activity will
help you

² understand the basics of the layout of Mathcad documents and

² learn how you can a®ect your document's layout, in particular:

{ move regions around the document,

{ delete regions, and

{ resize Mathcad graphs.

Instructions
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Figure 2: The "Save As" dialog box lets you specify the location and name of the ¯le before it
is saved.

A "template" document has been created for this assignment. Unless your professor instructs you

otherwise, load the document REGIONS.MCD. The document should appear as shown in Figure 1.

In order to load the "template" document into Mathcad, select Open from the File menu. This
brings up the "Open" dialog box. The following shows how to load the document REGIONS.MCD
from the G: drive

{ select the "G Drive" from the "Drives" box (change the selected drive by clicking on the
box and typing the letter G);

{ select the directory G:n from the "Directories:" box;

{ select (or type) the ¯le name, REGIONS.MCD under the "File Name:" box;

{ click on the "OK" button.

Save your work frequently.

Mathcad has two "save" items on the File menu:

¤ Save As... - opens up the "Save As" dialog box which lets you specify the location
(drive and directory) and name for the ¯le before it's saved (see Figure 2). "Save As"
allows you to create a new version of a ¯le while allowing you to keep the previous

version.

¤ Save - saves the current ¯le without changing its location or name. The e®ect of
"Save" is to overwrite your old version of a ¯le with the current state of the document.
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If your template is loaded from a read-only network drive (G:), you must do your ¯rst "save" using
Save As... so that you can change the location of the ¯le to your home directory. We assume
your home directory is on drive "F:". The Save command can now be used until the assignment
is completed. When you are ready to submit your document for grading, use Save As ... to
change the destination to directory "F:nTOPROF". Figure 2 shows an example where the directory
has been changed to "F:nTOPROF". Note the (circled) "F:nTOPROF" in the line directly underneath
"Directories:" - this is the indicator of the ¯le destination.

The left side of the document contains a picture of what the right side should become. However,
at the moment, the regions on the right side are badly out-of-place and out-of-shape. Follow these
steps to set things straight:

1. Begin by typing your team's name, and the teammembers' names at the top of the document.

Start saving the document at regular intervals (see Comment 1).

2. Follow the procedure described below to move the region "x:=0,0.1..19" to its proper position.
As a result, the sine and cosine graphs should appear. (The explanation for this is that the
region you just moved gives Mathcad a valid domain for these graphs - also see Comment 2).

In order to move a region in the Mathcad document, follow these steps:

(a) Select the region. To select a region, move the pointer close to (but outside) the region
you want to move. Holding down the left mouse button, drag the pointer into the region.
Release the left mouse button once the pointer is within the region. The region should
now be enclosed in a dotted frame (referred to as selection rectangle in Mathcad manual)
and the pointer should turn into a big black cross:

(b) Drag the region to the desired location.

3. Follow the procedure described below to delete the text region which says "Cut this region
please!". (Be careful not to delete any other regions in the process!)

In order to delete an entire region, follow step 2(a) to select the region, then use Cut from
the Edit menu.

4. Follow the procedure described below to resize each of the to graphs to make them look like
the graphs on the left side. Finally, move both graphs into the proper position.

In order to resize a graph region:

(a) Follow step 2(a) to select the region.

(b) With the left mouse button released, move the pointer towards the bottom right corner

of the frame, until the black cross changes into a double-headed arrow (-&):

(c) Drag the bottom right corner to the desired position (the top left corner remains ¯xed).
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If you want to change the width of the graph only, move it to the right side of the frame. A
di®erent double-headed arrow will appear (Ã!), allowing you to alter the width.

Likewise, moving the pointer towards the bottom side of the graph frame, produces the arrow
(l) that can be used to change the graph's height.

5. Visually verify that the right side of the screen looks like the left. Ask for help if you have
trouble accomplishing this.

You are now ready to tackle the "Mathcad Basics" activity!

Comments

1. Multiple regions can be moved or deleted by initially dragging the pointer across more than
one region. Alternatively, individual regions can be added to the selection (or omitted from
it) by using the <Shift> key while clicking on the region.

2. Mathcad reads its documents just like we do: from top to bottom, left-to-right. If a region
requires information from another, then it must be position to the right, or below that region.

To see exactly where the regions are, and in which order Mathcad processes them, select
View Regions from the Edit menu. As a result, the screen areas not occupied by regions
are marked gray. The black dot at the left side of each region is called its anchor - it is
the position of the region's anchor, relative to other anchors, that determines the ordering of
regions within the document.

0.2 Activity: Mathcad Basics

The objective of this activity is to introduce the basic features of Mathcad: entering and editing
expressions, de¯ning and graphing functions, and numerically solving equations.

Instructions

A "template" document has been created for this assignment. Before proceeding, read the com-
ments below. Unless your professor instructs you otherwise, load the document BASICS.MCD. Follow
the instructions on the screen to begin creating your lab report. After the "¯ll-in the blanks" por-
tion of the assignment answer the problems identi¯ed by your instructor. Remember to enter your
team's name at the top of the document. Upon completion of the assignment, enter the names of
all team members who actively participated in the assignment. Save your work frequently.

Comments

1. Carefully read all instructions and examples. Ask questions if you need any help. It is

expected that all team members will actively participate in solving every problem.
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2. The "hand" symbol indicates that you are being asked to perform some task, e.g.:

2. Evaluate 210 1

Type: 2 ^ 10 + 1 =
   F

You should place your answer to the right of this symbol.

3. After you submit your assignment and your professor grades it, you will be given instructions

regarding the retrieval of your assignment. If your assignment is returned to you electronically,
you may want to print it for your records (select Print from File menu).

Problems

1. At the end of the template document, you will ¯nd the expression
e
1+¼

4 ¡
¯̄̄
11

³
3

5+
p
5
+ 7

´¯̄̄
¼ + e+ 1

:

Copy the expression into your document, then cut the numerator and replace it with
p
2+1:

Evaluate the new expression.

2. De¯ne the function f(x) = x+ 2 sinx and evaluate f(1).

3. Graph f(x) from the previous Problem on [¡4; 6] in steps of 0:1: Chose "points" for the
"trace type".

4. (a) Use zoom and crosshair to approximate the smallest positive x such that F (x) = G(x)

where

F (x) = 10sin

Ã
x2

15

!
and G(x) = ¡x cos x

2
¡ 4:

Evaluate the di®erence F (x)¡G(x) at the value of x you found.

(b) Use the root function to improve upon the approximation obtained in part (a).

(Hint: F (x) = G(x) is equivalent to F (x) ¡G(x) = 0, therefore you are looking for a
root of F (x)¡G(x) .)

Evaluate the di®erence F (x)¡G(x) at the new value of x you just found.

Recap

Listed below are some of the important topics covered in this laboratory activity.

1. Arithmetic operations: The operations of addition, subtraction, multiplication and division
are represented by the symbols +; ¡; ¤; and = .
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Example

Let us define a function f( )t .t
2

2 ( )t 5 . It is clear that f has three roots: ,2 2

and 5. Here we have plotted f(t) for t ..,3 2.99 7

2 0 2 4 6
100

0

100

f( )t

0

2 2

t

Before we can use the root function, we have to  
provide Mathcad with an initial guess  for the root: t 1.5

then we can ask Mathcad for the root: =root ( ),f( )t t 1.414

Depending on the initial guesses, 
we may get different roots...

t 2 =root ( ),f( )t t 1.414

t 4 =root ( ),f( )t t 5

... or none at all: t 3.5 =root ( ),f( )t t

not converging

As we can see in the Example, if the initial guess is close  to one of the roots  of the function,  
then the Mathcad's root function will find that root .

Figure 3: Example of use of the Mathcad's "root" function.

To raise an expression to a power, type ^ (<shift>-6).

2. To evaluate an expression, follow it by the = (equal) symbol.

3. To de¯ne a variable, i.e. assign a value to it, use the symbol := , produced when you type :
(colon).

4. Navigating through expressions can be accomplished using the arrow keys and the space bar.

Expressions (or portions thereof) can be cut, copied and/or pasted using the system clipboard.

5. Mathcad has several built-in functions (e.g.,
p
x;sin(x)) and constants (e.g., ¼; e) sometimes

called prede¯ned variables..

6. You can de¯ne your own functions, e.g. f(x):=x+2 .

7. A function, say f(x), can be graphed by ¯rst de¯ning a range variable, e.g.,
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x:=-3,-2.99..2

(note that the two dots are obtained by typing the semicolon - ;). You can then chooseCreate
X-Y Plot from the Graphics menu, and ¯ll in the middle x-axis and y-axis placeholders
with x and f(x), respectively.

Graphs of more than one function can be included on the same plot, if you separate the
names of functions to be plotted with commas in the middle y-axis placeholder.

8. Graphs can be scaled manually (by changing the extreme placeholders along each axis) or
using the "zoom" feature.

To make Zoom selection available, click on a graph so that it is enclosed in the blue frame.
You will then see the X-Y Plot menu appear, from which Zoom can be selected. On the
same menu, you will also ¯nd the Crosshair selection, useful for reading coordinates o® the

graph.

9. The "Graph Format" dialog box can be used to change the appearance of the graph. To
invoke the dialog, double-click on the graph.

One possible use for the "Graph Format" dialog is to change the graphs "trace type" from
"lines" to "points".

10. When numerically solving an equation, one may use Mathcad's "root" function - Figure 3
contains an example of its use, taken from the template document.

Figure 4: The "Numerical Format" dialog box can be used to control the number of digits
displayed by Mathcad.
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Some Numerical Considerations

In the ¯rst activity ("Mathcad Basics") you used Mathcad to evaluate ¼; its response: 3.142. Unless
instructed otherwise, Mathcad displays all answers to three decimal places. Internally, however,
Mathcad keeps approximately 15 decimal digits for each number it uses. Keep in mind that when
these numbers are used in calculations, the results are typically less accurate. 1

In spite of losing accuracy during calculations, we can frequently use more than three decimal
places reliably. In order to get Mathcad to display more digits, you can double-click on a number
(which resulted from evaluation). This will bring up the "Numerical Format" dialog box shown in
Figure 4. In this dialog, you can change the "Displayed Precision" from its default value (3) to any
number up to 15. You could also make these changes a®ect all of your document, by ¯rst selecting

the "GLOBAL" button. (The dialog box can also be invoked from the Math menu.)

We should mention here another situation in which Mathcad's numerical results may di®er from
the exact values. Whenever Mathcad evaluates a product whose ¯rst factor is 0 (or a quotient
with 0 in the numerator), it always yields 0, regardless of the rest of the expression. While this
"shortcut", taken for e±ciency reasons, usually does not create problems, one should note that
Mathcad will cheerfully evaluate: 0

0
= 0 even though the expression has no value.

1 Many numerical procedures (e.g., Mathcad's root ¯nder) try to get approximate results within a certain
prescribed tolerance from the true (unknown) solution. In Mathcad, the tolerance is controlled by the variable
TOL. The default value of TOL is 0.001, which roughly means that the procedures in°uenced by TOL (root ¯nder,
as well as numerical di®erentiation and integration which we will learn about later) keep roughly three digits of
accuracy in their answer. The tolerance can be changed, e.g. assigning TOL:=0.000001 would roughly double the
number of accurate digits in the answer. This increase in accuracy comes at the expense of slower performance. (You
can also access the TOL value by selecting Built-in Variables from the Math menu.)


